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1. Introduction 
The real power of bringing public health data into QGIS Desktop is realized when you are able 

to conduct spatial analyses. Spatial analysis means creating new data and information, which is 

derived from existing datasets. The information provided from measuring proximity, conducting 

spatial queries, and intersecting datasets leads to insights unobtainable in tabular data.  

2. Objective: Understand How To Conduct Basic Spatial 

Analyses in QGIS Desktop 
In this lab exercise, you will explore some basic ways to turn data into information. You will 

learn some basic spatial analysis techniques, including clipping a data layer, buffering features, 

creating heat maps, and selecting records by both attributes and location. The data for this lab 

covers Baltimore City and focuses on diabetes. 

 Task 1 – Clipping Data 

 Task 2 – Measuring Proximity 

 Task 3 – Selecting Features 

 Task 4 – Calculating Areas and Density 

3. Lab Tasks 

Task 1. Clipping Data 
In this task, you will learn how to spatially constrain data to the study area using a GIS operation 

known as clipping. 

1) Open QGIS Desktop and open the Lab4.qgs project file. 

2) With one exception, this map has the same data you worked with in Lab 3. There is a 

new dataset representing fast food restaurant locations. 
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3) This layer obviously extends beyond the limits of Baltimore City. Right click on the 

FACCESS_MD_FastFood_CLF layer and choose Zoom to Layer from the context 

menu to see the full extent of the layer.  

4) This layer covers all of Maryland. 

5) Click the  button to return to the Baltimore City extent. 

6) You are only interested in Baltimore City. You will clip this layer to the spatial extent 

of Baltimore City, but first familiarize yourself with the data. Click the Identify 

Features tool and click on one of the FACCESS_MD_FastFood_CLF icons on the map 

to see what type of attributes the layer has. 

 

 

7) Close the Identify Results window when finished. 

8) Open the Layer Properties for the FACCESS_MD_FastFood_CLF layer. Select the 

General tab. 

9) Is this dataset in the same CRS as the other layers?  

10) This layer is in WGS 84 Pseudo Mercator. Close Layer Properties. 
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11) Before you clip this layer to the Baltimore City limits, it needs to be in the same CRS as 

the Baltimore City Boundary. You will first re-project this layer.  

12) Right click on the FACCESS_MD_FastFood_CLF layer and choose Save As… from 

the context menu.  

13) The Save vector layer as… window opens. 

a) Select ESRI Shapefile for the Format. 

b) You will be creating a new copy of this layer in the same Maryland State Plane 

CRS used by the other map layers. Browse to the Lab4/MyData folder and name 

it MD_FastFood_SPCS.shp. Here you will employ a naming convention. Ending 

the layer name with SPCS will remind you that this layer is in the State Place 

Coordinate System (SPCS).  

c) Click the  button for the CRS. This opens the Coordinate Reference System 

Selector window. At this point you should have 

NAD_1983_StatePlane_Maryland_FISP_1900_Feet (EPSG: 102685) listed in 

the Recently used coordinate reference systems window. If not, type 102685 in 

the Filter text box and select this CRS. 

d) Click OK when done. 

 

e) Back at the Save vector layer as… window, click OK to re-project this 

shapefile.  
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14) A blue bar across the top of the map canvas will signify the process has completed and 

the MD_FastFood_SPCS layer will be added to the Layers panel. 

15)  Now you are ready to clip this layer to the Baltimore City Boundary polygon. 

16) Click Vector | Geoprocessing Tools | Clip to open the Clip tool. 

a) The Input vector layer will be MD_FastFood_SPCS. 

b) The Clip layer will be Baltimore City Boundary. 

c) Click Browse for the Output shapefile, navigate to the Lab4/MyData folder, and 

name this new layer Baltimore_FastFood.shp. 

d) Click OK. 
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17) Turn off the two other Fast food layers and you will see the new layer consisting of just 

the restaurants within the Baltimore City boundary. 

18) To Style this new layer, right click on the original Fast food layer 

(FACCESS_MD_FastFood_CLF) and choose Styles | Copy Style from the context 

menu. 

19) Right click on the Baltimore_FastFood layer and choose Styles | Paste Style from the 

context menu. 

20) Remove the other two Maryland-wide Fast food layers from the Layers panel. 

21) Congratulations, you clipped your first layer! 

22) Save your QGIS project.  
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Task 2. Measuring Proximity  
In this task, you will explore two ways to measure proximity. You will learn how to apply both 

the buffer tool and the heatmap tool to measure proximity to fast food restaurants in Baltimore 

City. 

1) Open QGIS Desktop and open the QGIS map document from Lab 4 Task 1. 

2) First, you will buffer the fast food restaurants. Buffer is an operation that creates a new 

polygon layer that is a specified buffer distance from another layer. Click the Vector 

menu | Geoprocessing | Buffer(s) to open the Buffer(s) tool. 

a) Input vector layer = Baltimore_FastFood 

b) Segments to approximate = 20 (QGIS cannot create true curves, but the higher 

this number the smoother the output will be.) 

c) Buffer distance = 1320 (¼ mile in feet) 

d) Check Dissolve buffer results (Checking this option will merge buffer polygons 

for each point together if they overlap.) 

e) Output shapefile = Lab4/MyData/FastFood_Buffer.shp 

f) Click Save and then OK. Close the Buffer window. 
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3) The new layer will appear on the map and in the Layers panel. Drag it beneath the 

Baltimore_FastFood layer. This new dataset shows the area of Baltimore that is within 

¼ mile of a fast food restaurant. With these data you could calculate the percentage of 

Baltimore that is within ¼ mile of a fast food restaurant. You will learn how to 

calculate acreages in Task 4. 
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4) That created some good information. Now you will learn another method of calculating 

proximity. You will create a “heat map” of the fast food restaurants in Baltimore City. 

A heat map is really more of a measure of density computed from point data. A raster 

surface will be interpolated from the point data. 

5) To do this, you will be using a QGIS plugin named Heatmap. It is a core QGIS plugin, 

so it is already installed. You just need to enable it. Click on the Plugins menu and 

choose Manage and Install Plugins.  

6) Select the Installed tab and click the box next to Heatmap. 

 

7) Click Close. 

8) This tool will now appear under the raster menu. Click Raster | Heatmap | Heatmap. 

9) Complete the tool with the following inputs: 

a) Input point layer | Baltimore_FastFood 

b) Output raster | Lab4/MyData/FastFood_Heatmap.img 

c) Output format | Erdas Imagine Images (.img) 

d) Radius | 5280 map units 

e) Click the Advanced checkbox to access some advanced settings 

f) Enter Cell size X and Cell size Y values of 100 

g) Kernel shape | Epanechnikov  

h) Click OK. 

NOTE: the Kernel shape controls how the influence of a given point decays as the 

distance from it increases. For example, a triweight kernel gives features greater 

weight for distances closer to the point than the Epanechnikov kernel does. 

Consequently, triweight results in “sharper” hotspots, and Epanechnikov results in 

“smoother” hotspots. A number of standard kernel functions are available in 

QGIS, which are described and illustrated in Wikipedia.  

http://en.wikipedia.org/wiki/Kernel_(statistics)#Kernel_functions_in_common_use
http://en.wikipedia.org/wiki/Kernel_(statistics)#Kernel_functions_in_common_use
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10) A raster image will appear styled on a black-to-white color ramp. 
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11) Now you will style this raster layer. Open the Layer Properties | Style tab for the 

FastFood_Heatmap layer. 

NOTE: This tool does not work correctly with QGIS Version 2.8.1. Earlier and later 

versions work fine. It is recommended that you upgrade to QGIS 2.8.2 or later. 

a) Change the Render type to Singleband pseudocolor. 

b) Under Generate new color map choose the YlOrRd color ramp. 

c) Under Accuracy click Actual (slower) and click the Load button. 

d) Click Classify. 

e) Click OK. 

 

12) The map will now resemble the figure below. 
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13) This layer extends beyond the Baltimore City boundary. Now you will clip the heat 

map layer. Click on the Raster menu | Extraction | Clipper to open the Clipper 

window. 

a) Input file (Raster) = FastFood_Heatmap 

b) Output file = Lab4/MyData/FastFood_Heatmap_BC.img 

c) Click the Mask Layer radio button. 

d) Mask layer = Baltimore City Boundary 

e) Click OK. 
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14) Right click on the original heat map layer and choose Styles | Copy Style. 

15) Right click on the new clipped heat map layer and choose Styles | Paste style. 

16) Remove the original layer. 

 

17) Additional documentation on this plugin can be found on the QGIS.org website. 

18) Save your QGIS project file. 

Task 3. Selecting Features 
Selecting features is one of the core functions of a GIS. You may only be interested in a subset of 

a data layer. When you select spatial features, the corresponding records in the attribute table are 

also selected and vice versa. Any GIS operation can be run on just the selected set of 

records/features. For example, if you have counties of the U.S. and you select those in Vermont, 

you can save the selected features/records as a new GIS layer. Any GIS operation can be run on 

just the selected set. Selections can be done: 1) interactively, 2) using expressions to query the 

attributes of a layer, or 3) spatially. Here you will be introduced to all three methods. 

http://docs.qgis.org/2.6/en/docs/user_manual/plugins/plugins_heatmap.html
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Interactive Selection 

First let’s explore interactive selection. 

1) Open QGIS Desktop and open the QGIS map document from Lab 4 Task 2. 

2) Turn off the FastFood_Heatmap_BC layer and turn on the Neighborhood_diabetes 

layer. 

3) Select the Neighborhood_diabetes layer in the Layer panel.  

4) Click the Select Features by area or single click button. There is a dropdown tool 

menu that provides several ways to select features interactively. 

 

 

5) Choose Select Features(s). Click on a feature on the map. It will be highlighted in 

yellow. 

6) Open the attribute table for this layer. You will see that the corresponding record is also 

selected. 

7) Whenever you have a selected set of records, you can use the Show All Features 

dropdown menu in the lower left corner to show only the selected records. There are 

several other options available on this menu. Click Show Selected Features. 

8) Now you can see just the selected records and can sort just the selected records by the 

various columns. 

9) Close the table when done.  

10) This tool can also be used to select multiple features. Using the tool, click and drag a 

box with your left mouse button across a portion of the city. All the polygons you 

interacted with will become selected. 

11) To unselect these features click the  button. 
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Using Expressions To Query the Attributes of a Layer 

Now you will explore attribute queries using the select by expression tool to select 

neighborhoods with high poverty rates. 

1) Open the Neighborhood_diabetes attribute table. 

2) In addition to the diabetes data you joined to this table there are a lot of columns of 

socio-economic data. 

3) Click on the  button to open the Select by expression window. 

4) On the left is the window where you will form your SQL expression. In the middle are 

the available Functions. On the right is a context window that provides help and 

sample field values. Across the top are commonly used Operators. 

 

5) Expand the Fields and Values functions, and the attribute columns in this layer will be 

listed. 

6) Select the Poverty field. 

7) The right window splits into the Help and Values window. On top are some hints. Next 

to Load values click all unique. QGIS will scan the column and print all the unique 

values in the Poverty column for this layer. These represent the poverty rate. 
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8) Double-click on Poverty to add it to the Expression area. 

9) Scroll up the list of Functions and expand the Operators section. 

10) Double click on the > operator to add it to the Expression area. 

11) Scroll back down and reselect the Fields and Values | Poverty column. 

12) Again, next to Load values click all unique. 

13) To complete your expression you can either use one of these values by double clicking 

on it, or you can type a numeric value into the expression window. Double click on 20 

to complete your expression. 



Community Health Maps Lab Series: Lab 4—Basic Spatial Analysis 

11/23/2015  Page 16 of 25 

 

 

 

14) With your expression complete, click the Select button. 

15) 117 neighborhoods match your query. They are selected both on the map and in the 

table. 

16) Close the Select by Expression window. 

17) For more information on using the Select by expression tool, visit the QGIS 

documentation page for this tool.

http://docs.qgis.org/2.6/en/docs/user_manual/working_with_vector/expression.html
http://docs.qgis.org/2.6/en/docs/user_manual/working_with_vector/expression.html


Community Health Maps Lab Series: Lab 4—Basic Spatial Analysis 

11/23/2015  Page 17 of 25 

Spatial Selection  

Another useful technique is feature selection by location. This allows you to select features in 

one layer that intersect or touch features in another layer.  

1) You will use the select by location tool to identify neighborhoods with a fast food 

restaurant. Click the Vector menu | Research Tools | Select by Location.  

a) Select features in: Neighborhood_diabetes 

b) that intersect features in: Baltimore_FastFood 

c) Check Include input features that intersect the selected features. 

d) Click OK. 

e) Click Close. 

 

2) The neighborhood polygons that intersect a fast food restaurant point are now selected 

in yellow. Right click on the Neighborhood_diabetes layer and choose Open Attribute 

Table. 
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3) There are 271 records in the table, meaning there are 271 neighborhoods in Baltimore 

City. Of those 85 (31%) are now selected, meaning they have a fast food restaurant. 

4) Scroll to the right side of the table where the BaltCity_D column is. This is the column 

that contains the number of people diagnosed with diabetes. Remember, you joined this 

column to the neighborhoods layer in Lab 3 Task 2. 

5) Click the column header to sort the table based on these diabetes values. Scroll up and 

down and observe the values. Notice that the majority of neighborhoods with high 

diabetes totals are selected. Close the table. 

6) Click on the Vector menu | Analysis Tools | Basic statistics. This will give you an 

interface for calculating basic statistics on numeric attributes.  

a) Input vector layer = Neighborhood_diabetes 

b) Check Use only selected features. 

c) Target field = BaltCity_D 

d) Click OK. 

7) Basic statistics on the number of diabetics in the selected neighborhoods are now 

displayed in the main window.  
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8) This shows that 40,433 diabetics live in these neighborhoods with easy fast food access. 

9) Repeat this, but uncheck the Use only selected features option. Click OK. This shows 

that there are a total of 82,831 diabetics living in Baltimore City. You now know that of 

those, almost 50% are within neighborhoods with easy fast food access! Close the 

Basic statistics window. 

10) Using the same workflow in steps 8–11, determine what percentage of diabetics live in 

neighborhoods within ¼ mile of a fast food restaurant. For this, you will use the 

FastFood_Buffer layer. 

11) You can use the  button to unselect the records when done. 

12) Save your QGIS project when done. 

Task 4. Calculating Areas and Density 
It is often useful to be able to calculate areas and distances. In this task, you will learn how to 

calculate the square mileage of each neighborhood and then calculate the population density. 

1) Open QGIS Desktop and open the QGIS map document from Lab 4 Task 3. 

2) Turn off the Baltimore_FastFood layer. 

3) Open the attribute table for the Neighborhood_diabetes layer. 
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4) You will add a column and then populate that new column with the area in square 

miles. Click the  button. It is located in the upper right corner of the attribute table.  

5) This puts the table into edit mode. Several buttons will now become active. It also puts 

the spatial layer into edit mode, and you may see the vertices of the neighborhoods 

show up as red X’s.  

6) Click the  button to open the Add column window. 

a) Name = SqMi 

b) Type = Decimal number (real) 

c) Width = 5 (the total number of digits the column will hold) 

d) Precision = 1 (the number of decimal places the column will hold) 

e) Click OK. 

7) Scroll to the right to see the new column. 
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8) Click on the  button to open the Field Calculator window. This allows you to 

populate the new column with values. 

a) Check Update existing field option. 

b) Choose SqMi as the field to update. 

c) You will set up an expression in the left most window. There are operators in the 

middle window with some information in the right window. From the list of 

Functions, expand Geometry.  

d) Double click on $area. Click on the * (multiplication symbol). 

e) Enter the conversion factor from square feet to square miles: 

0.000000358700642792. 

f) Click OK. The new field will be populated with the square mileage. 

 

9) Add a second column named PopDensity, Type = Decimal number (real), Width = 6, 

and Precision = 1. 
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10) Now open the Field Calculator. This time you will expand Fields and Values from 

the Functions list. You will divide the population by the square mileage to generate 

people per square mile.  

a) Set it up so that you are updating the existing field PopDensity. 

b) Double click on the population column F2010_Popu. 

c) Click the division symbol /. 

d) Double click on the square mileage column SqMi. 

e) Click OK. 

11) Click the  button to end the editing session. Save your edits. 
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12) Close the attribute table. 

13) Right click on the Neighborhood_diabetes shapefile and choose Duplicate from the 

context menu. This creates a copy of the layer in the Layers Panel. 

14) Open the Layer Properties | General tab for the new layer. Rename the layer 

Population Density. 

15) Switch to the Style tab. 

16) Style the layer as follows: 

a) Switch the Column | PopDensity 

b) Change the Color ramp | Blues 

c) Click the Classify button to change the values to those in the new column. 

d) Click OK. 

 



Community Health Maps Lab Series: Lab 4—Basic Spatial Analysis 

11/23/2015  Page 24 of 25 

17) Now you have generated a map of population density. 

 

18) Add another column named DiabDen with the same parameters as the population 

density column.  

19) Populate the DiabDen column with the expression: "BaltCity_D" / "SqMi". This will 

generate density of diabetics per square mile. 

20) Duplicate the Neighborhood_diabetes layer again. Rename this layer Diabetic Density. 

21) Style this layer as you did the Population density layer, but with the DiabDen column 

and a different color ramp (OrRd). 

22) Turn on just the new Diabetic Density layer and the Dialysis Centers layer. 
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23) Save your QGIS Map document.  

4. Conclusion 
In this lab you have learned the basics of performing spatial analysis within QGIS Desktop. 

QGIS has very robust spatial analysis capabilities. Almost anything you can envision is possible, 

if you have the data to support it. Continue to explore the Raster and Vector menus. There are 

hundreds of additional spatial analysis tools in the Processing | Toolbox. The GeoAcademy GST 

102 course offers additional spatial analysis resources. 

https://foss4geo.wordpress.com/gst-102-spatial-analysis-using-qgis/
https://foss4geo.wordpress.com/gst-102-spatial-analysis-using-qgis/
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